
 1

WebEx Recording Editor Users Guide 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright and trademarks 
2001 WebEx Communications, Inc. All rights reserved. 

WebEx, WebEx Player, WebEx Recorder, WebEx Recording Editor, and the WebEx logo are 
trademarks of WebEx Communications, Inc. 
Other product or brand names are trademarks or registered trademarks of their respective 
holders. 
  



 2

 

Table Of Contents 
Table Of Contents ........................................................................................................................ 1 
Introducing WebEx Recording Editor ........................................................................................... 5 

Contacting WebEx Communications............................................................................................ 5 

Receiving Technical Support........................................................................................................ 5 

Providing Feedback to WebEx ..................................................................................................... 5 
Providing Feedback About WebEx Products and Services.................................................. 5 
Providing Feedback About This Documentation................................................................... 5 

GETTING STARTED ....................................................................................................................... 6 

Starting WebEx Recording Editor ................................................................................................ 6 

Overview of WebEx Recording Editor .......................................................................................... 6 

System Requirements for Audio Playback................................................................................... 7 

Viewing the WebEx Recording Editor Window ............................................................................ 7 

Customizing Your Workspace...................................................................................................... 8 

Specifying Preferences ................................................................................................................ 8 

Quitting WebEx Recording Editor ................................................................................................ 8 

Uninstalling WebEx Recording Editor .......................................................................................... 9 

OPENING AND SAVING A RECORDING .................................................................................... 10 

Opening a Recording ................................................................................................................. 10 

Saving an Edited Recording....................................................................................................... 10 

PLAYING A RECORDING ............................................................................................................ 11 

About Playing a Recording......................................................................................................... 11 

Playing a Recording ................................................................................................................... 11 

Pausing Playback....................................................................................................................... 12 

Resuming Playback.................................................................................................................... 13 

Rewinding a Recording .............................................................................................................. 13 

Fast Forwarding a Recording ..................................................................................................... 13 

Stopping Playback...................................................................................................................... 13 

Setting the Playback Volume ..................................................................................................... 14 

Muting Audio During Playback ................................................................................................... 14 

Unmuting Audio During Playback .............................................................................................. 14 

Selecting Recorded Data ........................................................................................................... 14 

About Selecting Recorded Data ................................................................................................. 14 

Selecting a Range of Time......................................................................................................... 14 

Selecting a Segment .................................................................................................................. 15 



 3

Selecting a Snapshot ................................................................................................................. 16 

Selecting a Frame ...................................................................................................................... 16 

NAVIGATING A RECORDING...................................................................................................... 17 

About Navigating a Recording ................................................................................................... 17 

Scrolling Through a Recording................................................................................................... 17 

Viewing Snapshots on a Timeline .............................................................................................. 17 

Viewing Frames on a Timeline ................................................................................................... 17 

Setting a Current Location.......................................................................................................... 18 

Going to a Specific Segment...................................................................................................... 19 

Going to the Next or Previous Segment..................................................................................... 19 

Going to a Specific Marker ......................................................................................................... 19 

Going to the Beginning or End of a Timeline ............................................................................. 20 

Going to the Current Location .................................................................................................... 20 

WORKING WITH MARKERS........................................................................................................ 21 

About Working with Markers ...................................................................................................... 21 

Inserting a Marker ...................................................................................................................... 21 

Moving a Marker......................................................................................................................... 22 

Deleting a Marker ....................................................................................................................... 22 

Editing Marker Properties........................................................................................................... 23 

EDITING RECORDED DATA........................................................................................................ 24 

About Editing Recorded Data..................................................................................................... 24 

Cutting, Copying, and Pasting Recorded Data .......................................................................... 24 
Cutting Recorded Data ........................................................................................................... 24 
Copying Recorded Data ......................................................................................................... 25 
Pasting Recorded Data........................................................................................................... 25 

Viewing the Contents of the Clipboard....................................................................................... 26 

Truncating the Beginning of a Recording................................................................................... 27 

Truncating the Ending of a Recording........................................................................................ 27 

Inserting Another Recording....................................................................................................... 27 

Preventing Fast Forward During Playback................................................................................. 29 

WORKING WITH RECORDED SEGMENTS................................................................................ 30 

About Working with Segments ................................................................................................... 30 

Defining a Segment.................................................................................................................... 30 

Editing a Segment ...................................................................................................................... 33 

Cutting, Copying, and Pasting Segments .................................................................................. 33 
Cutting a Segment .................................................................................................................. 33 
Copying a Segment ................................................................................................................ 34 
Pasting a Segment ................................................................................................................. 34 

Sequencing Segments ............................................................................................................... 35 



 4

Inserting a Segment into a Sequence ........................................................................................ 35 

Building a Recording from Segments......................................................................................... 35 

Merging Segments ..................................................................................................................... 36 

Renaming a Segment................................................................................................................. 36 

Undefining a Segment................................................................................................................ 36 

Deleting a Segment.................................................................................................................... 37 

CLIPBOARD PALETTE ................................................................................................................ 38 

MARKERS PALETTE ................................................................................................................... 39 

MARKER PROPERTIES DIALOG BOX ....................................................................................... 40 

PREFERENCES DIALOG BOX .................................................................................................... 42 

DEFINE SEGMENT/SEGMENT PROPERTIES DIALOG BOX.................................................... 43 

SEGMENTS PALETTE ................................................................................................................. 45 

SEQUENCE EDITOR WINDOW ................................................................................................... 46 

Clipboard Palette................................................................................................................. 46 
Current Location   Indicator................................................................................................. 46 
Define Segment Dialog Box................................................................................................ 46 
Elapsed Time and Duration Indicator.................................................................................. 46 
File Properties Dialog Box................................................................................................... 46 
Marker Properties Dialog Box ............................................................................................. 47 
Markers Palette ................................................................................................................... 47 
Preferences Dialog Box ...................................................................................................... 47 
Segment Properties Dialog Box.......................................................................................... 48 
Segments Palette................................................................................................................ 48 
Sequence Editor Window.................................................................................................... 48 
Set Location Palette ............................................................................................................ 48 
Split Segment Dialog Box ................................................................................................... 49 
Volume Palette.................................................................................................................... 49 

Menu Bar .................................................................................................................................... 49 

Elapsed Time and Duration Indicator......................................................................................... 49 

Timeline ...................................................................................................................................... 49 

Toolbar ....................................................................................................................................... 49 

Viewer......................................................................................................................................... 51 

GLOSSARY................................................................................................................................... 52 

Index........................................................................................................................................... 55 



 5

  
 

Introducing WebEx Recording Editor 

WebEx Recording Editor allows you to edit WebEx Recorded Files (.wrf). WebEx Recorded 
Files are recordings that were made using either the stand-alone version WebEx Recorder or 
the recorder that is integrated with a meeting service.  
Using WebEx Recording Editor, you can 

 play a recording 
 navigate a recording, and view snapshots or individual frames of recorded data 
 define segments of recorded data on a timeline, so you can quickly locate sections of a recording 
during playback, using WebEx Player 

 cut or copy recorded data on a recording's timeline, then paste it at another location on the 
timeline 

 insert recorded data, including images and audio, from one recording into another recording 
 insert an entire WebEx Recorded File (.wrf) into a recording 
 delete recorded data, including images and audio, from a recording 
 rearrange recorded data on a recording's timeline 
Note Currently, you cannot edit audio independently of video in recorded data. 

 
Contacting WebEx Communications 

Receiving Technical Support 

WebEx provides comprehensive technical support services for its customers. If you cannot find 
an answer to your question in WebEx Recording Editor Help, or you are experiencing problems 
with WebEx Recording Editor, you can receive technical support by doing one of the following: 

 For urgent issues, call 408-435-7088, Monday through Friday, 7 a.m. to 7 p.m. Pacific time. 
 For non-urgent issues, send an email message to support@webex.com. 

  
Providing Feedback to WebEx 

WebEx Communications greatly appreciates any feedback you provide about our products and 
documentation. 

Providing Feedback About WebEx Products and Services 

You can provide feedback to WebEx Communications by sending an email message to 
feedback@webex.com. 

Providing Feedback About This Documentation 

At WebEx Communications, we strive to provide the best possible documentation for our 
products. If you have comments about this Help or other WebEx documentation, please send 
an email message to docs@webex.com. 
In your email message, please specify the Help topic or section to which your comment 
applies. If you would like to receive a response to your comments, please include your name 
and contact information in your message.  
If you have a technical question, please contact WebEx technical support.  
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Getting Started 

Starting WebEx Recording Editor 

To start WebEx Recording Editor, do one of the following on your computer's desktop: 
 Click Start, point to Programs, point to WebEx Recording and Playback, then click WebEx 
Recording Editor. 

 Double-click the WebEx Recording Editor 
shortcut.  

The WebEx Recording Editor window appears. 
Overview of WebEx Recording Editor 

WebEx Recording Editor displays recorded data on a timeline. The timeline in the WebEx 
Recording Editor window displays a series of snapshots that represent 10 seconds of recorded 
data, which includes images and any audio that was captured in the recording. You can 
optionally view miniatures, or thumbnails, of individual frames on a timeline in another 
window. 
WebEx Recording Editor allows you to play, listen to audio in, and navigate a recording, so you 
can locate the points at which you want to edit recorded data. The Current Location indicator 
shows the current location on the timeline during playback. You can move this indicator to 
finely adjust the current location. 
To edit a recording, you can simply select data on its timeline, then cut or copy it and paste it 
at another location. Or, you can define segments that is, specific ranges of recorded data 
that you can label, delete, rearrange, copy, paste at another location on the timeline, or insert 
into another recording's timeline. 
To define a segment or perform other editing tasks, you insert markers on a recording's 
timeline. You can insert starting and ending point markers to define a range or segment of 
recorded data, and cue point markers, which allow you to return to a precise location on the 
timeline. 
The following are some examples of how you can use WebEx Recording Editor: 

 Define sections of recorded data to which you can quickly navigate during 
playback Insert starting and ending point markers on the timeline to define the ranges of data 
that you want to identify. Define each range of data as a segment. You can then display a list of 
the segments in WebEx Player to jump to any segment in the recording. 

 Delete part of a recording Insert starting and ending point markers on the timeline to define 
the range of data that you want to delete. Define the range of data as a segment, then delete the 
segment from the timeline. 

 Insert recorded data into another recording's timeline Open two recordings. On one 
recording, define a segment that includes the data that you want to insert into the other 
recording. Copy the segment, then insert into the timeline of the other recording. 

 Rearrange recorded data on a timeline Define segments of recorded data. Open the 
Sequence Editor window, then, in the list of segments, rearrange them into their new positions 
relative to one another. 
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System Requirements for Audio Playback 

When using WebEx Recording Editor, you can listen to audio in a recording if your computer 
has  

 a Creative Labs Sound Blaster or equivalent sound card 
  Note Refer to your meeting service Support page for a list of supported sound cards. 

 speakers, or a headphone jack and headphones 
  
Viewing the WebEx Recording Editor Window 

The following figure shows the WebEx Recording Editor window, in which a recording is open. 
Click the different areas of the figure to learn more about the window. 
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Customizing Your Workspace 

You can customize the appearance of the WebEx Recording Editor window, as follows: 
 Show or hide the timeline 
 Show or hide the toolbar 
 Show or hide all palettes at once that is, the Volume palette, Markers palette, Segments palette, 
and the Clipboard palette. 

You can also specify preferences for the windows and palettes. For details, see Specifying 
Preferences. 
To show or hide the timeline: 
  On the View menu, choose Timeline. 
  A checkmark next to the Timeline command indicates that the timeline appears in the WebEx 

Recording Editor window. 
To show or hide the toolbar: 
  On the View menu, choose Toolbar. 
  A checkmark next to the Toolbar command indicates that the toolbar appears in the WebEx 

Recording Editor window. 
To show or hide all palettes at once: 
  On the View menu, choose one of the following, as appropriate:  
  If no palettes are currently open, choose Show Palettes. 

If at least one palette is currently open, choose Hide All Palettes.  
 
Specifying Preferences 

You can specify preferences for WebEx Recording Editor. You can specify 
 whether or not various windows and palettes always float on top of the WebEx Recording Editor 
window 

 how to sort markers in the Markers palette 
 how to sort segments in the Segments palette 

To specify user preferences for WebEx Recording Editor: 
1 On the Edit menu, choose Preferences. 
  The Preferences dialog box appears. 
2 Specify preferences. 
  For information about the options on the Preferences dialog box, see the topic Preferences Dialog 

Box. 
3 Once you have finished specifying preferences, click OK. 
 

Quitting WebEx Recording Editor 

To quit WebEx Recording Editor, on the File menu, choose Exit. 
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Uninstalling WebEx Recording Editor 

You can remove WebEx Recording Editor from your computer, using your computer’s 
Add/Remove Programs utility. 

Important Uninstalling WebEx Recording Editor also uninstalls WebEx Recorder, WebEx 
Player, and the WebEx meeting client software on your computer. Once you uninstall the client 
software, you must reinstall it to schedule, start, or join a meeting on your meeting service 
Web site. 
To uninstall WebEx Recording Editor: 
1 On your computer's desktop, double-click My Computer. 
2 Open the Control Panel folder. 
3 Double-click Add/Remove Programs. 
  A dialog box appears, with a list of programs installed on your computer. 
4 In the list, select WebEx client. 
5 Click Add/Remove. 
  The WebEx Client Uninstall dialog box appears. 
6 In the list, select the WebEx client. 
  Note If WebEx clients appear for both Internet Explorer and Netscape Navigator, select the 

client for the Web browser that you used when downloading and installing WebEx Recorder, 
WebEx Player, and WebEx Recording Editor. If you are unsure about which browser you were 
using, delete both clients, one at a time. 

7 Click Remove. 
  The WebEx Client Uninstall program removes the client software from your computer. 
8 Click OK. 
9 On your computer’s desktop, delete the shortcuts for WebEx Recorder, WebEx Player, and 

WebEx Recording Editor, if any. 
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Opening and Saving a Recording 

Opening a Recording 

You can open any recording made using WebEx Recorder. WebEx Recorder files have a .wrf 
extension. 
To open a recording: 
1 On the toolbar, click Open. 

 
  The Open Recording dialog box appears. 
2 Locate the recording that you want to open. 
3 Click Open. 
  
Saving an Edited Recording 

You can save a recording that you have edited. If you have previously saved an edited 
recording, you can save a copy of the recording to another file. 
To save an edited recording: 
1 On the toolbar, click Save. 

 
  The Save Recording As dialog box. 
2 Choose a location at which to save the file. 
3 Type a name for the file in the File name box. 
4 Click Save. 
 

To save a copy of an edited recording: 
1 On the File menu, choose Save As. 
  The Save Recording As dialog box. 
2 Optional. Choose a new location at which to save the file. 
3 Optional. Type a new name for the file in the File name box. 
4 Click Save. 
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Playing a Recording 

About Playing a Recording 

WebEx Recording Editor allows you to play back a WebEx Recorded File (.wrf) in the viewer. 
You can play back a recording to monitor the recorded data to determine the points at which 
you want to edit it.  
When playing a recording, you can 

 pause and resume playback 
 fast forward or rewind the recording 
 stop playback 
 set the playback volume 
 mute and unmute audio 

 
Playing a Recording 

In the WebEx Recording Editor window, you can play back  
 an entire recording 
 recorded data that follows a specific location in a recording 
 recorded data that follows a marker 
 a single segment of a recording 
 a sequence of segments of a recording 
   

To play back an entire recording: 
1 On the timeline, move the Current Location indicator to the beginning of the recording. 
  For instructions on moving the Current Location indicator, see Setting a Current Location. 
2 Do one of the following: 
  On the Controls menu, choose Start Playback.  

On the toolbar, click the Play button. 
 
Right-click the timeline. 
Then, on the Timeline pop-up menu, choose Start Playback.  

  
To play back recorded data that follows a specific location in a recording: 
1 Move the Current Location indicator to the point at which you want to begin playback. 
  For instructions on moving the Current Location indicator, see Setting a Current Location. 
2 Do one of the following: 
  On the Controls menu, choose Start Playback.  

On the toolbar, click the Play button. 
 
Right-click the timeline. 
Then, on the Timeline pop-up menu, choose Start Playback.  

  
To play back recorded data that follows a marker: 
1 On the timeline, select a marker. 
2 Right-click the marker that you selected. 
3 On the Marker pop-up menu, choose Start Playback. 
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To play back a single segment of a recording: 
Do either of the following: 

 Use the Segments palette, as follows: 
  On the View menu, choose Segments. 

The Segments palette appears. 
Select the segment that you want to play back. 
Click Play.  

 Use the timeline, as follows: 
  On the timeline, select the segment that you want to play back. 

For instructions on selecting a segment on the timeline, see Selecting a Segment. 
Right-click the segment. 
On the Segment pop-up menu, choose Start Playback.  

  
To play back a sequence of segments of a recording: 
1 On the View menu, choose Segments. 
  The Segments palette appears. 
2 Press and hold the Ctrl key. 
3 Select the segments that you want to play back. 
4 Click Play. 
  

Notes 
 During playback, the Current Location indicator shows the current location on the timeline. The 
Elapsed Time and Duration indicator tracks the movement of the Current Location indicator.  

 In the Frame View window, playback is restricted to the range of time represented on its 
timeline. 

 For information about markers, see About Working with Markers. 
 For information about segments, see About Working with Segments. 

 
Pausing Playback 

When playing a recording, you can pause playback at any time. 
To pause playback: 
  Do one of the following: 
  On the toolbar, click the Pause button  

 
On the Controls menu, choose Pause .  
Right-click the timeline in either the main window or the Frame View window, then choose Pause 
Playback.  
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Resuming Playback 

When playback is paused, you can resume playback at any time. 
To resume playback: 
  Do one of the following: 
  On the toolbar, click the Resume button  

 
On the Controls menu, choose Start Playback.  
Right-click the timeline, then choose Start Playback.  

 
Rewinding a Recording 

During playback, you can rewind a recording, either one snapshot or frame at a time or to its 
beginning. 
To rewind a recording one snapshot or frame at a time: 
1 Play the recording.  
  For detailed instruction on playing a recording, see Playing a Recording. 
2 On the toolbar, click the Rewind button.  

 
  Each time you click the Rewind button, the Current Location indicator moves one snapshot 

backward on the timeline in the WebEx Recording Editor window, or one frame backward on the 
timeline in the Frame View window. 

To rewind a recording the its beginning: 
  On the Control menu, choose Rewind to Beginning.  
  The Current Location indicator moves to the beginning of the recording's timeline. 
 
Fast Forwarding a Recording 

During playback, you can fast forward a recording, either one snapshot or frame at a time or 
to its end. 
To fast forward a recording one snapshot or frame at a time:  
1 Play the recording.  
  For detailed instruction on playing a recording, see Playing a Recording. 
2 On the toolbar, click the Fast Forward 

button.   
  Each time you click the Fast Forward button, the Current Location indicator moves one 

snapshot forward on the timeline in the WebEx Recording Editor window, or one frame forward 
on the timeline in the Frame View window. 

To fast forward a recording to its end: 
  On the Control menu, choose Fast Forward to End.  
  The Current Location indicator moves to the end of the recording's timeline. 
 
Stopping Playback 

When playing a recording, you can stop playback at any time. 
Depending on which part of a recording you are playing back, playback stops automatically 
once the entire selection plays back or when playback reaches the end of the frames on the 
timeline. 
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To stop playback: 
  Do one of the following: 
  On the toolbar, click the Stop button.  

 
On the Controls menu, choose Stop Playback.  
Right-click the timeline, then choose Stop Playback.  

 
Setting the Playback Volume 

You can set the playback volume for a recording either before you begin playback or during 
playback. 
To set the playback volume: 
1 On the toolbar, click the downward-pointing 

arrow to the right of the Volume button.  
  The Volume palette appears. 
2 Do either of the following: 
  Adjust the volume by dragging the slider. 

Press Ctrl+Up Arrow to increase the volume; or Ctrl+Down Arrow to reduce the volume.  
 
Muting Audio During Playback 

To mute audio during playback, on the 
toolbar, click the Mute button  
 
Unmuting Audio During Playback 

To unmute audio during playback, do one of the following: 
 On the toolbar, click the Unmute button 
 

 Drag the Volume slider to increase the volume.  
 Press Ctrl+Up Arrow to increase the volume.  

 
Selecting Recorded Data 

About Selecting Recorded Data 

To perform many editing tasks, you must select recorded data on the timeline. You can select 
a 

 range of time 
 segment 
 snapshot 
 frame 

 
Selecting a Range of Time 

You can select a range of time on the timeline. When you select a range of time, the selected 
range appears highlighted on the lower part of the timeline. You can select a range of time 
between any two points, frames, snapshots, cue point markers, or starting and ending point 
markers. 
Once you select a range of time, you can extend the range in either direction on the timeline.  
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To select a range of time between any two points: 
1 On the timeline, press the mouse button to set an anchor point. 
2 Drag the mouse forward or backward over the timeline. 
3 Release the mouse button to set an end point. 
  
To select a range of time between two frames or snapshots: 
1 Optional: If you want to select a range of time between two frames, open the Frames View 

window. For details, see Viewing Frames on a Timeline. 
2 On the timeline, click the first frame or snapshot in the range to set an anchor point. 
3 Scroll to the end of the range that you want to select. 
4 Holding down the Shift key, click the last frame or snapshot in the range to set an end point.  
  
To select a range of time between two cue points: 
1 On a timeline, select a cue point marker. 
2 Scroll to another cue point marker at the end of the range that you want to select. 
3 Holding down the Shift key, click the second cue point marker. 
  
To select a range of time between starting and ending points: 
1 Hold down the Ctrl key. 
2 Click a starting point marker   or ending point marker . 
  The range of time between the starting and ending points appears highlighted.   
  
To extend the range of a selection in either direction: 
1 Hold down the Shift key. 
2 Drag the mouse over the timeline to extend the selection. 
3 Release the mouse button to set the end point. 
 
Selecting a Segment 

You can select a segment to edit its properties, or to cut or copy it to the Clipboard. You can 
select a segment on either the timeline or in the Sequence Editor window, which contains a list 
of all segments that you have defined. 
To select a segment on the timeline in the WebEx Recording Editor window: 
  Do either of the following: 
  Click the colored portion of the upper part of the timeline that demarcates a segment.  

Hold down the Ctrl key and click either the segment's starting point marker or, if it is visible, its 
ending point marker   

  Both of the markers that define the segment appear highlighted and the entire segment appears 
highlighted on the lower part of the timeline. 

  
To select one or more segments in the segments list in the Sequence Editor window: 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 In the list of segments, do one of the following: 
  Click a segment.  

Hold down the Shift key, then select contiguous segments.  
Hold down the Ctrl key, then click noncontiguous segments.   
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TipOnce you select a segment, you can 

view its properties. To do so, on the toolbar, 
click the Properties button to display the 
Segment Properties dialog box. 
 
Selecting a Snapshot 

To select a snapshot on the timeline in the WebEx Recording Editor window, click the 
snapshot.  
The snapshot appears highlighted. 
 
Selecting a Frame 

To select an individual frame of recorded data, you must first open the Frames View window. 
For details, see Viewing Frames on a Timeline. 
To select a frame on the timeline: 
  In the Frame View window, click the frame. 
  The frame appears highlighted. 
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Navigating a Recording 

About Navigating a Recording 

To locate the specific point at which you want to edit a recording, you can navigate the 
recording, using any of several methods, including 

 scrolling through a recording's timeline 
 fast forwarding a recording 
 rewinding a recording 
 setting the Current Location indicator 
 going to a specific segment of recorded data that you have defined on a recording's timeline 
 going to the next or previous segment on a recording's timeline 
 going to a specific marker that you have inserted on a recording's timeline 
 going to the beginning or end of a recording's timeline 
 going to the current location on a recording's timeline that is, the point on a timeline at which 
the Current Location indicator resides 

When navigating a recording, you can view either snapshots that is 10-second intervals of 
recorded dataor individual frames on a recording's timeline. 
 
Scrolling Through a Recording 

To quickly navigate to another part of a recording's timeline, without changing the current 
location or selection, you can scroll through a recording, using any of the following methods: 

 Drag the timeline scroll box to the right or left.  
 Click to the right of the scroll box to scroll to the right.  
 Click to the left of the scroll box to scroll to the left.  
 Click the right-pointing scroll arrow to scroll to the right, one snapshot at a time.  
 Click the left-pointing scroll arrow to scroll to the left, one snapshot at a time.   

 
Viewing Snapshots on a Timeline 

The timeline in the WebEx Recording Editor window displays snapshots of a recording. Each 
snapshot represents 10 seconds of recorded data.  

 
The upper part of the timeline displays time in increments of ten seconds and fractions of ten 
seconds. Specifically, the increment marks on the upper part of the timeline demarcate 2.5-
second, 5-second, 7.5-second, and 10-second intervals of time. 
 
Viewing Frames on a Timeline 

You can view individual frames on a recording's timeline. Viewing frames allows you to more 
precisely edit a recording. For example, when viewing frames, you can set the Current 
Location indicator at any 0.05-second interval on the timeline. 
To view frames on a timeline: 
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1 Move the Current Location indicator to a location on the timeline. 
  For instructions on moving the Current Location indicator, see Setting a Current Location. 
2 On the toolbar, click the View Selected 

Frames button.  
  The Frames View window appears, displaying the frames that correspond to the snapshot 

immediately preceding and the two snapshots following the Current Location indicator.  

 
Notes 
 The timeline in the Frame View window displays time in increments of 0.4 second. Specifically, 
the increment marks on the upper part of the timeline demarcate 0.1-second, 0.2-second, 0.3-
second, and 0.4-second intervals of time. Each frame in a recording is 0.4 second. 

 If a recording includes audio, the Frame View window also shows the amplitude of the audio 
signal for the audio track of the recording. Each audio packet is 0.05 second. 

 You must close the Frame View window to again use the timeline in the WebEx Recording Editor 
window.  

 
Setting a Current Location 

The current location is the location on the timeline of the data that currently appears in the 
viewer. The Current Location indicator shows the current location on the timeline. You must 
set the current location on the timeline to perform editing activities, such as inserting markers 
and recorded data. 
To move the current location to a selected snapshot, frame, or range of time: 
1 Optional: If you want to set the current location at a specific frame, open the Frames View 

window.  
  For details, see Viewing Frames on a Timeline. 
2 Scroll to a location on the timeline. 
3 Select a snapshot, frame, or range of time. 
4 On the toolbar, click the Set Current 

Location button.  
To move the current location to a selected marker: 
1 Scroll to a marker on the timeline. 
2 Select a marker. 
3 On the toolbar, click the Set Current 

Location button.  
To move the current location incrementally, or to finely adjust the current location:  
  Do one of the following: 
  On the timeline, drag the Current Location indicator forward or backward.  

On the toolbar, click the downward-pointing 
arrow to the right of the Set Current 
Location button.    

  
Note You can also set a current location by doing one of the following: 
 Play the recording, then stop or pause it at the location at which you want to set the current 
location. For details, see Playing a Recording. 

 Go to a specific marker that you have inserted on the timeline. For details, see Going to a 
Specific Marker. 
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 Go to a specific segment that you have defined on the timeline. For details, see Going to a 
Specific Segment. 

 Go to the next or previous segment on the timeline. For details, see Going to the Next or 
Previous Segment. 

 Go to the beginning or end of the timeline. For details, see Going to the Beginning or End of a 
Timeline. 

 
Going to a Specific Segment 

If you have defined a segment in a recording, you can go directly to a segment's starting point 
marker on the timeline, without starting playback. When you go to a segment, the Current 
Location indicator moves directly to the starting point marker for that segment. 
To go to a specific segment: 
1 On the Controls menu, point to Segment. 
2 On the submenu, click the name of the segment. 
- Or - 
1 On the toolbar, click the View Segments 

button.  
  The Segments palette appears. 
2 In the list of segments, select a segment.  
3 Click Go To. 
- Or-  
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears. 
2 In the list of segments, select a segment. 
 
Going to the Next or Previous Segment  

If you have defined segments in a recording, you can go to the next or previous segment's 
starting point marker on the timeline. 
When you go to the next or previous segment, the Current Location indicator moves directly to 
the starting point marker for that segment. 
To go to the next or previous segment during playback: 
1 Play the recording.  
  For detailed instruction on playing a recording, see Playing a Recording. 
2 On the toolbar, do one of the following: 
  Click the Next Segment button 

 
Click the Previous Segment button.  
  

To go to the next or previous segment without starting playback: 
1 Right-click the timeline. 
2 On the menu that appears, point to Go To, then do one of the following: 
  To go to the next segment on the timeline, choose Next Segment.  

To go to the previous segment on the timeline, choose Previous Segment.  
 
Going to a Specific Marker 

If you have defined markers, you can go to a specific marker on a recording's timeline. When 
you go to a marker, the Current Location indicator moves directly to the marker. 
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To go to a specific marker: 
1 On the toolbar, click the View Markers 

button.  
  The Markers palette appears. 
2 In the list of markers, select a marker.  
3 Click Go To. 
Going to the Beginning or End of a Timeline 

You can quickly navigate to the beginning or end or a recording's timeline. If you go to the 
beginning or end of a timeline, the Current Location indicator moves to that location. 
To go to the beginning or end of a timeline: 

 To go to the beginning of the timeline, press the Home key.  
 To go to the end of the timeline, press the End key. 

- Or - 
1 Right-click the timeline. 
2 On the menu that appears, point to Go To, then do one of the following: 
  To go to the beginning of the timeline, choose Beginning.  

To go to the end of the timeline, choose End.  
 
Going to the Current Location 

If you are viewing a recording's timeline, you can quickly navigate to the point on the timeline 
at which the Current Location indicator resides. 
To go to the Current Location indicator: 
  On the Control menu, choose Go To Current Location. 
  The WebEx Recording Editor window automatically scrolls to the point at which the Current 

Location indicator resides on the timeline. 
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Working with Markers 

About Working with Markers 

A marker is a flag that you insert to indicate a point on the timeline at which an action is to 
occur or to which you can jump. You can insert pairs of markers to indicate the starting and 
ending points of a range of time or segment. You can also insert cue point markers, which are 
useful for marking any location to which you want to return. 
Once you insert a marker, you can  

 move it to another location on a timeline 
 edit its properties 

 
Inserting a Marker 

You can insert the following types of markers on a recording's timeline: 
 cue point marker 
 starting point marker 
 ending point marker 

You can insert a marker at a specific frame, snapshot, or beginning of a range of time; or at a 
precise location on a timeline. 

To insert a marker on the timeline: 
1 Scroll to a location on the timeline. 
2 Select a snapshot, frame, or a range of time on the timeline. 
3 On the toolbar, select one of the following buttons, as appropriate: 
  

Insert Cue Point   

Insert Starting Point   

Insert Ending Point   
  A marker appears at the left boundary of the selected frame or snapshot, or to the left of the 

selected range of time, then the Marker Properties dialog box appears. 
4 Specify the properties of the marker. 
  For information about the options on the Marker Properties dialog box, see the topic Marker 

Properties Dialog Box. 
  
To insert a marker at a precise location on the timeline: 
1 Move the Current Location indicator to a location on the timeline. 
  For instructions on moving the Current Location indicator, see Setting a Current Location. 
2 On the toolbar, select one of the following buttons, as appropriate: 
  

Insert Cue Point   

Insert Starting Point   

Insert Ending Point   
  A marker appears at the current location, then the Marker Properties dialog box appears. 
3 Specify the properties of the marker. 
  For information about the options on the Marker Properties dialog box, see the topic Marker 

Properties Dialog Box. 
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Notes 
 If you insert a marker during playback, playback stops automatically. 
 You can point to a marker to display a ToolTip, which indicates the marker's type, number; and 
name; or in the case of starting and ending point markers that define a segment, the segment's 
number, marker type, and marker's name. 

 Starting and ending point markers that you insert consecutively—that is, between which no 
intervening starting or ending point markers exist—automatically constitute a pair of markers.  

 If you insert a starting point marker, but no ending point marker, the end of the recording 
automatically constitutes the ending point of the range or segment. 

 If you insert a starting point marker, but no ending point marker, then insert another starting 
point marker, the second starting point marker automatically constitutes the ending point of the 
first range or segment, and WebEx Recording Editor automatically inserts an ending point marker 
at the same location as the second starting point marker.  

 

Moving a Marker 

Once you insert a cue point, starting point, or ending point marker on the timeline, you can 
adjust the marker's position.  
To move a marker: 
1 Do any of the following: 
  Drag the marker on the timeline. 

Select a marker, then press the Right Arrow or Left Arrow key to move the selected marker 
continuously along the timeline.  
Hold down the Ctrl key while pressing the Right Arrow or Left Arrow key to move a selected 
marker by a distance that is approximately equivalent to the width of the window.   

  If you moved a starting or ending point marker that defines a segment, a message appears, 
asking you whether you want to redefine the segment. 

2 If you moved a starting or ending point marker that defines a segment, in the message box that 
appears, click Yes. 
Notes 
 You can also move a marker by editing the marker's properties to change the precise time at 
which it appears on the timeline. For details, see Editing Marker Properties. 

 If starting and ending point markers reside at the same location on the timeline, moving one 
such marker moves both markers simultaneously. 

 
Deleting a Marker 

You can delete any marker that you have inserted on a recording's timeline. 
To delete a marker: 
1 On the timeline, select a marker to delete. 
2 On the Edit menu, choose Clear. 

Notes 
 If you clear a starting point marker that defines a range or segment of recorded data, a message 
box appears, asking you whether you want to remove or edit the associated ending point marker. 
Removing the ending point marker undefines the range or segment of recorded data. 

 If you clear an ending point marker that defines a range or segment of recorded data, a message 
box appears, asking you whether you want to remove or edit the associated starting point 
marker. Removing the starting point marker undefines the range or segment of recorded data. 
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Editing Marker Properties 

You initially define the properties of a cue point, starting point, or ending point marker when 
inserting it. However, you can edit the following properties for a marker:  

 the marker's name 
 whether the marker is a cue point, starting point, or ending point, if the marker is not already 
either the starting or ending point of a segment 

 the marker's location on the timeline 
 the name of the segment, if the marker is either a starting point or ending point for a segment 

 

To specify the properties of an existing cue point marker: 
1 If necessary, locate the marker for which you want to specify new properties.   
  For instructions on locating a marker, see the topic Going to a Specific Marker. 
2 Select the cue point marker. 
3 On the toolbar, click the Properties button. 

 
  The Marker Properties dialog box appears. 
4 Specify new properties for the marker. 
  For information about the options on the Marker Properties dialog box, see the topic Marker 

Properties Dialog Box. 
Tip You can point to a marker to display a ToolTip, which indicates the marker's type, 

number; and name; or in the case of starting and ending point markers that define a 
segment, the segment's number, marker type, and marker's name. 
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Editing Recorded Data 

About Editing Recorded Data 

You can edit a recording to  
 cut or copy, then paste recorded data on the timeline 
 truncate, or cut, the beginning or ending of a recording 
 insert another recordingthat is, an entire .wrf fileon the timeline 
 prevent a user from fast forwarding a recording during playback 
Note If you define segments on a recording's timeline, you can perform additional editing 

activities. For more information about editing a recording using segments, see About Working 
with Segments. 
 
Cutting, Copying, and Pasting Recorded Data 

Cutting Recorded Data 

On a recording's timeline, you can cut a 
 segment that you have defined 
 range of recorded data 
 snapshot of recorded data 
 single frame of recorded data 

Cutting recorded data places it on the Clipboard. You can then paste the recorded data at 
another location on a recording's timeline. 
To cut recorded data: 
1 If you want to cut a specific frame or range of frames, open the Frames View window.  
  For details, see Viewing Frames on a Timeline. 
2 On the timeline, select the recorded data. 
3 On the toolbar, click the Cut button. 

 
  A message box appears, allowing you to confirm the deletion. 
4 Click Yes. 
  WebEx Recording Editor places the recorded data on the Clipboard, which appears automatically. 

Notes 
 If you cut a segment or range of recorded data from the timeline, and no previously defined 
segment or range immediately precedes or follows it, WebEx Recording Editor automatically 
inserts a cue point marker at that location. The Cue Point Marker Properties dialog box appears, 
allowing you to name the marker or cancel its insertion. 

 You cannot cut recorded data on the timeline during playback or when playback is paused. 
 The Clipboard palette allows you to view information about its contents and paste it at another 
location. For details, see Viewing the Contents of the Clipboard. 

 Once you save a recording from which you cut data, its file may be smaller, depending on the 
amount of recorded data that you cut. Typically, the file size does not change if you cut fewer 
than four minutes of recorded data. 
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Copying Recorded Data 

On a recording's timeline, you can copy a 
 segment that you have defined 
 range of recorded data 
 snapshot of recorded data 
 single frame of recorded data 

Copying recorded data places it on the Clipboard. You can then paste the recorded data at 
another location on a recording's timeline. 
To copy recorded data: 
1 If you want to copy a specific frame or range of frames, open the Frames View window. For 

details, see Viewing Frames on a Timeline. 
2 On the timeline, select the recorded data. 
3 On the toolbar, click the Copy button. 

 
  WebEx Recording Editor places the recorded data on the Clipboard, which automatically appears. 

Notes 
 You cannot copy recorded data on the timeline during playback or when playback is paused. 
 The Clipboard palette allows you to view information about its contents and paste it at another 
location. For details, see Viewing the Contents of the Clipboard. 

 

Pasting Recorded Data 

You can cut or copy data in a recording to the Clipboard, then paste it to 
 another location in the same recording 
 a location in another recording 

On a timeline, you can paste recorded data before a selected frame or snapshot or a specific 
location. You can also paste recorded data into a segment list, such that it appears before a 
selected segment. 
To paste recorded data to the left of a selected frame or snapshot on the timeline: 
1 Cut or copy recorded data to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting Recorded Data 

Copying Recorded Data  
2 Scroll to a location on the timeline. 
3 Select a snapshot or frame. 
4 On the toolbar, click the Paste button. 

 
  The data that resides on the Clipboard appears to the left of the selected snapshot.  
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To paste recorded data at a specific location on the timeline: 
1 Cut or copy recorded data to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting Recorded Data 

Copying Recorded Data  
2 Move the Current Location indicator to the precise point on the timeline at which you want to 

begin the recording. 
  For details, see Setting a Current Location. 
3 On the Controls menu, choose Pause Playback. 
4 Optional: On the toolbar, click the Insert Cue 

Point button to insert a cue point marker.  
5 On the toolbar, click the Paste button. 

 
  The data that resides on the Clipboard appears at the current location.  
  
To paste recorded data into the segment list in the Sequence Editor window: 
1 Cut or copy recorded data to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting Recorded Data 

Copying Recorded Data  
2 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
3 Select the segment before which you want to insert the data on the Clipboard. 
4 On the toolbar, click the Paste button. 

 
  The data that resides on the Clipboard appears before the current selection in the segment list. 
  

Notes 
 If you paste a selected frame, snapshot, range of recorded data, segment, or entire recording to 
another location on a timeline or to another timeline, any markers that are part of the selected 
data are also pasted. Markers on the timeline are renumbered to reflect their new sequence on 
the timeline.  

 You cannot paste recorded data on the timeline during playback or when playback is paused.  
 
Viewing the Contents of the Clipboard 

Once you cut or copy recorded data on the timeline, WebEx Recording Editor places it on the 
Clipboard. You can open the Clipboard to view information about its contents or to  

 copy the current selection on the timeline to the Clipboard 
 paste the contents of the Clipboard on the timeline 
 clear the contents of the Clipboard 

To view the contents of the Clipboard: 
  On the View menu, choose Clipboard. 
  The Clipboard palette appears. 
  For information about the options on the Clipboard, see the topic Clipboard Palette. 
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Truncating the Beginning of a Recording 

You can delete all recorded data that precedes a specific location on the timeline. Truncating 
the beginning of a recording does not place any data on the Clipboard. 
To truncate the beginning of a recording: 
1 Move the Current Location indicator to the precise point on the timeline at which you want to 

begin the recording. 
  For details, see Setting a Current Location. 
2 On the Edit menu, point to Truncate, then choose Beginning. 
  The Truncate Beginning message box appears, allowing you to confirm the deletion.  
3 Click Yes. 
  The data preceding the Current Location indicator on the timeline is deleted, and the previous 

location of the Current Location indicator becomes 00:00:00 on the timeline. 
Notes 
 You can determine the point at which you want the recording to begin by playing the recording. 
Allow playback to proceed until the Current Location indicator reaches the location on the 
timeline at which the recording should begin. Then stop or pause the recording. You can then 
finely adjust the current location indicator to ensure that it is at precisely the correct location.  

 Once you save a recording that you truncated, its file may be smaller, depending on the amount 
of recorded data that you cut. Typically, the file size does not change if you cut fewer than four 
minutes of recorded data. 

 
Truncating the Ending of a Recording 

You can delete all recorded data that follows a specific location on the timeline. Truncating the 
ending of a recording does not place any data on the Clipboard. 
To truncate the ending of a recording: 
1 Move the Current Location indicator to the precise point on the timeline at which you want to end 

the recording. 
  For details, see Setting a Current Location. 
2 On the Edit menu, point to Truncate, then choose Ending. 
  The Truncate Ending message box appears, allowing you to confirm the deletion.  
3 Click Yes. 
  The data following the Current Location indicator on the timeline is deleted, and the previous 

location of the Current Location indicator becomes the end of the timeline. 
Notes 
 You can determine the point at which you want to end the recording by playing the recording. 
Allow playback to proceed until the Current Location indicator reaches the location on the 
timeline at which the recording should end. Then stop or pause the recording. You can then finely 
adjust the current location indicator to ensure that it is at precisely the correct location. 

 Once you save a recording that you truncated, its file may be smaller, depending on the amount 
of recorded data that you cut. Typically, the file size does not change if you cut fewer than four 
minutes of recorded data. 

 
Inserting Another Recording 

You can insert another existing recording—that is, an entire .wrf file—on the timeline. A 
recording that you insert constitutes a new segment on the timeline, for which you can define 
properties. 
You can also build a recording by concatenating existing recordings—that is, entire .wrf files.  
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To insert a recording to the left of a selected snapshot, frame, or range of time on 
the timeline: 
1 If you want to insert a recording to the left of a specific frame, open the Frames View window. 

For details, see Viewing Frames on a Timeline. 
2 Scroll to a location on the timeline in the main window. 
3 Select a snapshot or a range of time on the timeline. 
4 On the Insert menu, choose Recording. 
  The Insert Recording dialog box appears. 
5 Select a recording in the list, then click Insert. 
  The inserted recording appears to the left of the selected snapshot or preceding the selected 

range of time. If the recording that you inserted does not include any segments, it becomes a 
segment, and the Segment Properties dialog box appears. Otherwise, a message box appears, 
informing you that the recording includes its own segments.  

6 Do one of the following.  
  If the Segment Properties dialog box appears, specify the segment's properties, then click OK. 

For information about the options on the Segment Properties dialog box, see the topic Segment 
Properties Dialog Box. 
 If a message box appears, click OK.  

  
To insert a recording at a specific location on the timeline: 
1 Move the Current Location indicator to the precise point on the timeline at which you want to 

insert the recording. 
  For details, see Setting a Current Location. 
2 On the Controls menu, choose Stop Playback or Pause Playback. 
3 Optional: On the Insert menu, point to Marker, then choose Cue Point to insert a cue point 

marker. 
4 On the Insert menu, choose Recording. 
  The Insert Recording dialog box appears. 
5 Select a recording in the list, then click Insert.  
  The inserted recording appears to the left of the selected snapshot or preceding the selected 

range of time. If the recording that you inserted does not include any segments, it becomes a 
segment, and the Segment Properties dialog box appears. Otherwise, a message box appears, 
informing you that the recording includes its own segments.  

6 Do one of the following: 
  If the Segment Properties dialog box appears, specify the segment's properties, then click OK. 

For information about the options on the Segment Properties dialog box, see the topic Segment 
Properties Dialog Box. 
 If a message box appears, click OK.  

  
To build a recording by concatenating existing recordings: 
1 Open the recording that is to constitute the first segment in a sequence of segments. 
2 Save the recording under a different name. 
3 Move the Current Location indicator to the end of the recording. 
  For details, see Setting a Current Location. 
4 Insert the next recording. 
  The inserted recording appears to the left of the selected snapshot or preceding the selected 

range of time. If the recording that you inserted does not include any segments, it becomes a 
segment, and the Segment Properties dialog box appears. Otherwise, a message box appears, 
informing you that the recording includes its own segments.  

5 Do one of the following: 
  If the Segment Properties dialog box appears, specify the segment's properties, then click OK. 

For information about the options on the Segment Properties dialog box, see the topic Segment 
Properties Dialog Box. 
 If a message box appears, click OK.  

6 Repeat steps 4 and 5 as many times as necessary.  
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Preventing Fast Forward During Playback 

You can modify the properties of a WebEx Recorded File (.wrf) to prevent users from fast 
forwarding the recording during playback. 
To prevent fast forward during playback: 
1 On the Edit menu, choose File Properties. 
  The File Properties dialog box appears. 
2 Select the Block fast forward during playback check box. 
3 Click OK. 
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Working with Recorded Segments 

About Working with Segments 

A segment is a part, or range, of recorded data for which you specify a name and starting and 
ending points. Once you define a segment, you can  

 move it to another location on a timeline 
 delete it from a timeline 
 cut or copy it, then paste it at another location on a timeline 
 merge it with other segments 
 change its position in sequence of segments 
 rename it 
 edit its properties, such as its starting and ending points on a timeline 
 insert it into a sequence of segments for another recording 
 combine it with segments from other recordings to build a new recording 
 undefine it, without deleting the data that it contains 
Note The names, or titles, of segments that you define are available in WebEx Player, 

allowing you to jump directly to a segment during playback. 
 
Defining a Segment 

You can define a segment of recorded data on a timeline, using one of several methods. A 
segment includes a starting point marker and an ending point marker, which together indicate 
the range of recorded data that the segment includes. 
You can define a segment by first inserting both starting and ending point markers, or only a 
starting point marker, then defining the segment's properties. Or you can define a segment's 
properties without first inserting markers. If you have defined another segment, you can use 
its ending or starting point marker to define a new segment that immediately follows or 
precedes it, respectively.  
You can also paste a range of recorded data, or an entire recording, and define it as a 
segment. 
To insert both starting and ending point markers for a segment, then define the 
segment: 
1 On the timeline, insert a starting point marker. 
2 Insert an ending point marker. 
3 Select the starting and ending point markers. 
4 On the toolbar, click the Define Segment 

button.  
  The Define Segment dialog box appears. Under Starting point, the location of the selected 

starting point marker appears in the Time box. Under Ending point, the location of the selected 
ending point marker appears in the Time box. 

5 Type a name for the segment in the Name box. 
6 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
7 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
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To insert only a starting point marker for a segment, then define the segment: 
1 On the timeline, insert a starting point marker. 
2 Select the starting point marker. 
3 On the toolbar, click the Define Segment 

button.  
  The Define Segment dialog box appears. Under Starting point, the location of the selected 

starting point marker appears in the Time box. 
4 Type a name for the segment in the Name box. 
5 Do one of the following: 
  Under Ending point, type the location of the segment's ending point in the Time box. 

With your cursor in the Time box under Ending point, move the Current Location indicator to the 
ending point. 
The location of the ending point appears in the Time box. 
With your cursor in the Time box under Ending point, select the starting point marker for the 
subsequent segment. 
The location of the selecting starting point appears in the Time box.  

6 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
7 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
  
To define a segment without first inserting starting and ending point markers: 
1 On the toolbar, click the Define Segment 

button.  
  The Define Segment dialog box appears. Under Starting point, the location of the Current 

Location indicator appears in the Time box. 
2 Type a name for the segment in the Name box. 
3 Optional: To set the starting point at another location, do one of the following: 
  Under Starting point, type the location of the segment's starting point in the Time box. 

With your cursor in the Time box under Starting point, move the Current Location indicator to 
the starting point. 
The location of the starting point appears in the Time box. 
With your cursor in the Time box under Starting point, select the ending point marker for the 
preceding segment. 
The location of the selecting ending point appears in the Time box.  

4 Do one of the following: 
  Under Ending point, type the location of the segment's ending point in the Time box. 

With your cursor in the Time box under Ending point, move the Current Location indicator to the 
ending point. 
The location of the ending point appears in the Time box. 
With your cursor in the Time box under Ending point, select the starting point marker for the 
subsequent segment. 
The location of the selecting starting point appears in the Time box.  

6 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
7 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
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To define a segment using the ending point marker of a segment that immediately 
precedes the segment being defined and the starting point marker of a segment that 
immediately follows it: 
1 Select the ending point marker of a segment that immediately precedes the segment being 

defined. 
2 On the toolbar, click the Define Segment 

button.  
  The Define Segment dialog box appears. Under Starting point, the location of the selected 

ending point marker appears in the Time box. 
3 Type a name for the segment in the Name box. 
4 With your cursor in the Time box under Ending point, select the starting point marker of a 

segment that immediately follows the segment being defined. 
  The location of the selected starting point marker appears in the Time box. 
5 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
6 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
  
To define a pasted range of recorded data as a segment: 
1 Select a range of recorded data that has no starting and/or ending point markers. 
2 Cut the selected range of recorded data. 
3 Move the Current Location indicator to the precise point on the timeline at which you want to 

paste the range of recorded data. 
  For details, see Setting a Current Location. 
4 Paste the range of recorded data at the current location on the timeline. 
  Starting and ending point markers for the range are inserted automatically, and the Define 

Segment dialog box appears.   
5 Type a name for the segment in the Name box. 
6 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
7 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
  
To define a pasted recording as a segment: 
1 Select an entire recording. 
2 Cut the recording. 
3 Move the Current Location indicator to the precise point on the timeline at which you want to 

paste the recording. 
  For details, see Setting a Current Location. 
4 Paste the recording at the current location on the timeline. 
  Starting and ending point markers for the range are inserted automatically, and the Define 

Segment dialog box appears.   
5 Type a name for the segment in the Name box. 
6 Optional: Define other properties of the segment. 
  For information about the options on the Define Segment dialog box, see the topic Define 

Segment Dialog Box. 
7 Click Define. 
  The new segment, and its starting and ending point markers, appear on the timeline. 
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Editing a Segment 

You can edit a segment to change any of the following properties: 
 name 
 starting point 
 ending point 

To edit a segment: 
1 Select a segment. 
  For details, see Selecting a Segment. 
2 On the toolbar, click the Properties button. 

 
  The Segment Properties dialog box for that segment appears. 
3 Specify new information about the segment. 
  For information about the options on the Segment Properties dialog box, see the topic Segment 

Properties Dialog Box. 
Note You can also edit a segment by moving it starting point or ending point marker on 

the timeline. For details, see Moving a Marker. 
 
Cutting, Copying, and Pasting Segments 

Cutting a Segment 

You can cut a segment that you have defined on a recording's timeline. Cutting a segment 
places it on the Clipboard. You can then paste the segment at another location on a 
recording's timeline. 
You can cut a segment directly on the timeline or in the Sequence Editor window. 
To cut a segment: 
1 On the timeline, select a segment to cut. 
2 On the toolbar, click the Cut button. 

 
  A message box appears, allowing you to confirm the deletion. 
3 Click Yes. 
  WebEx Recording Editor places the recorded data on the Clipboard.  
- Or - 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Select a segment to cut. 
3 Right-click your mouse anywhere in the list of segments. 
4 On the menu that appears, choose Cut. 
  WebEx Recording Editor places the recorded data on the Clipboard. 

Notes 
 If you cut a segment of recorded data from the timeline, and no previously defined segment 
immediately precedes or follows it, WebEx Recording Editor automatically inserts a cue point 
marker at that location. The Cue Point Marker Properties dialog box appears, allowing you to 
name the marker or cancel its insertion. 

 You cannot cut a segment on the timeline during playback or when playback is paused. 
 The Clipboard palette allows you to view information about its contents and paste it at another 
location. For details, see Viewing the Contents of the Clipboard. 

 Once you save a recording from which you cut a segment, its file may be smaller, depending on 
the amount of recorded data that you cut. Typically, the file size does not change if you cut fewer 
than four minutes of recorded data. 
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Copying a Segment 

You can copy a segment that you have defined on a recording's timeline. Copying a segment 
places it on the Clipboard. You can then paste the segment at another location on a 
recording's timeline. 
You can copy a segment directly on the timeline or in the Sequence Editor window. 
To copy a segment: 
1 On the timeline, select a segment to cut. 
2 On the toolbar, click the Copy button. 

 
  WebEx Recording Editor places the recorded data on the Clipboard.  
- Or - 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Select a segment to copy. 
3 Right-click your mouse anywhere in the list of segments. 
4 On the menu that appears, choose Copy. 
  WebEx Recording Editor places the recorded data on the Clipboard, which automatically appears. 

NoteThe Clipboard palette allows you to view information about its contents and paste it at 
another location. For details, see Viewing the Contents of the Clipboard. 
 

Pasting a Segment 

You can cut or copy a segment that you have defined on a recording's timeline to the 
Clipboard, then paste it to 

 another location in the same recording 
 a location in another recording 

On a timeline, you can paste a segment before a selected frame or snapshot or a specific 
location. You can also paste a segment into a segment list, such that it appears before a 
selected segment. 
To paste a segment to the left of a selected frame or snapshot on the timeline: 
1 Cut or copy a segment to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting a Segment 

Copying a Segment  
To paste a segment at a specific location on the timeline: 
1 Cut or copy the segment to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting a Segment 

Copying a Segment  
To paste a segment into the segment list in the Sequence Editor window: 
1 Cut or copy a segment to place it on the Clipboard. 
  For details, see one of the following topics: 
  Cutting a Segment 

Copying a Segment  
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Notes 
 If you copy a segment, then paste it on the timeline in the same recording, Recording Editor 
automatically renames the copy by appending a number to its original name. 

 If you paste a segment to another location on a timeline or to another timeline, the segment's 
starting and ending point markers are also pasted. Markers on the timeline are renumbered to 
reflect their new sequence on the timeline. 

 You cannot paste a segment on the timeline during playback or when playback is paused. 
 
Sequencing Segments 

If you have defined two or more segments on a recording's timeline, you can reorder the list 
segments to change their sequence in a recording. Or, you can paste a segment from another 
recording into the list of segments. 
To change the sequence of the segments in a recording:  
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Do one of the following: 
  Cut one or more segments from the segment list, then paste the segments at another location in 

the list.  
Copy or cut segments from another recording, then paste them into the segment list.   

Note You cannot sequence segments during playback or when playback is paused. 
 
Inserting a Segment into a Sequence 

If you have defined one or more segments on a recording's timeline, you can insert, or paste, 
a segment from another recording into the list of segments. 
To insert a segment into a sequence of segments in a recording:  
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Copy or cut segments from another recording, then paste them into the segment list.  
  For instructions on cutting, copying, and pasting segments, see one of the following topics, as 

appropriate: 
  Cutting a Segment 

Copying a Segment 
Pasting a Segment  

NoteYou cannot sequence segments during playback or when playback is paused. 
 
Building a Recording from Segments 

You can build a recording by concatenating either existing segments from various recordings 
or entire recordings—that is, .wrf files.  
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To build a recording by concatenating segments: 
  Do one of the following: 
  Copy or cut another segment from either the timeline in the WebEx Recording Editor window or 

the Sequence Editor window for that recording, then paste it at the appropriate location in the 
segment list. 
Copy or cut another entire recording from either the timeline in the WebEx Recording Editor 
window or the Sequence Editor window for that recording, then paste it at the appropriate location 
in the segment list. 
Insert another entire recording by choosing Recording on the Insert menu.  

 
Merging Segments 

You can create a single segment from two or more contiguous segments. 
To merge two or more selected segments: 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Select two or more contiguous segments in the segment list. 
3 Click Merge. 
  The merged segment receives the name of the topmost segment that you selected in the list. 

Note You cannot merge segments during playback or when playback is paused. 
 

Renaming a Segment 

If you have defined a segment on a recording's timeline, you can rename it. A segment's 
name identifies it in the Segment List palette and the Sequence Editor window. 
To rename an existing segment: 
1 On the timeline, select a segment to rename. 
2 On the toolbar, click the Define Segment 

button.  
  The Segment Properties dialog box appears. 
3 Type a new name in the Name box.  
4 Click Define. 
- Or - 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears, showing a list of segments that you have defined. 
2 Select a segment to rename. 
3 Click Rename. 
4 Type a new name. 
5 Press Return. 
 
Undefining a Segment 

If you have defined a segment on a recording's timeline, you can undefine it.  Undefining a 
segment removes its starting and ending point markers from the timeline, but does not 
remove the recorded data from the timeline. 
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To undefine an existing segment of a recording: 
1 On the timeline, select a segment to undefine. 
2 On the toolbar, click the Define Segment 

button.  
  The Segment Properties dialog box appears. 
3 Click Undefine. 
  The starting and ending point markers no longer define a segment, and become cue point 

markers. 
 Notes 
 You can also undefine a segment by doing either of the following: 

  Delete a segment's starting point marker. For details, see Deleting a Marker. 
Change a segment's starting point marker to another type of marker. For details, see Editing 
Marker Properties.  

 You cannot undefine a segment during playback or when playback is paused.  
 To remove a segment and its recorded data from the timeline, you can delete it. For details, see 
Deleting a Segment. 

 
Deleting a Segment 

You can delete any segment that you have defined on a recording's timeline. Deleting a 
segment also deletes the recorded data that it contains.  
To delete an existing segment: 
1 On the toolbar, click the Sequence Editor 

button.  
  The Sequence Editor window appears. 
2 In the list, select a segment to delete. 
3 Click Delete. 
  The Delete Segment message box appears, allowing you to confirm the deletion.  
4 Click Yes.  
  The entire segment is deleted, including the recorded data that it contains. 
- Or - 
1 On the timeline, select a segment to delete. 
2 On the Edit menu, choose Clear. 
  The Delete Segment message box appears, allowing you to confirm the deletion.  
3 Click Yes.  
  The entire segment is deleted, including the recorded data that it contains. 

Notes 
 You cannot delete a segment in the segment list during playback or when playback is paused.  
 To remove a segment without deleting its recorded data from the timeline, you can undefine it. 
For details, see Undefining a Segment. 

 Once you save a recording from which you delete a segment, its file may be smaller, depending 
on the amount of recorded data that the segment contained. Typically, the file size does not 
change if you delete a segment that contains fewer than four minutes of recorded data. 
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Clipboard Palette 

The Clipboard palette displays the current contents of the Clipboard, if any. 
  

Copy  : Copies the current selection on the timeline and places it on the Clipboard. 

Paste  : Inserts the contents of the Clipboard, as follows: 
 If the content is a range of recorded data, a segment, or an entire recording, it inserts  

  the recorded data, segment, or recording either at the current location or preceding any recorded 
data that is currently selected on a timeline  
the segment or recording before the current selection in the segment list in the Sequence Editor 
window   

 If text the content is text, it inserts the text at the insertion point that is currently selected; or 
replaces any selected text. 

Clear Clipboard  : Clears the current contents of the Clipboard. 
  

Clipboard Contents: The Clipboard Contents box displays the current contents of the 
Clipboard. If the content is recorded data or a marker, this box contains a symbol that 
represents the type of data on the Clipboard and one of the following: 

 the starting and ending times for a range of recorded data 
 the name of a segment or marker 

The following symbols represent the various data types that may reside on the Clipboard: 
A frame or range of recorded data 
Segment of recorded data 

If the content is text, the Clipboard Contents box contains the first part of the text. 
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Markers Palette 

The Markers palette contains a list of all the markers that you have inserted on a timeline.  
  

Type: Contains a marker symbol that indicates the type of each marker in the list. Click the 
column heading to sorts the markers in the list according to their type—initially, in the 
following order: 

 starting point markers 
 ending point markers 
 cue point markers 

Time: Indicates the time at which each marker resides on the timeline, in hours, minutes, and 
seconds (00:00:00.0). Click the column heading to sort the markers in the list by time, 
according to the order in which they occur on the timeline. By default, the list is sorted by 
time in ascending order. 
Name: Indicates the name of each marker on the timeline. Click the column heading to sort 
the markers in the list in alphabetical order, initially in ascending order. 

  
Go To: Moves the Current Location indicator to the marker that is selected in the list and 
selects the marker on the timeline.  
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Marker Properties Dialog Box 

Use the Marker Properties dialog box to define or edit information about a cue point, starting 
point, or ending point marker. 

  
Number: Indicates the number of a marker of a given type on the timeline. Markers of the 
following types are automatically numbered in sequential order: 

 cue point markers 
 pairs of starting and ending point markers that define a segment 
 pairs of starting and ending point markers that define a range of time 

Pairs of starting and ending point markers share the same number. A segment number applies 
to the starting and ending point markers for a segment. 
You cannot edit this number. 
Name: Specifies the name of the marker. To specify a marker's name, type it in this box.  A 
marker's name can include any characters. 
Time: Specifies the location of the marker on a timeline, in hours, minutes, and seconds 
(00:00:00.0). By default, the location at which you inserted a marker on the timeline 
appears in this box. You can edit the time by doing either of the following: 

 Type a time in the proper format, hh:mm:ss.s 
 Select the number of hours, minutes, or seconds in the box, then click the Up button  to 
increase the number or click the Down button  to decrease the number. 

==============  
Type: Specifies a marker's type. The type of marker that you chose when inserting the 
marker appears in this box. To change a marker's type, select a type in the drop-down list. 

 Cue point 
 Starting point 
 Ending point 

 

You cannot change a marker's type if the marker is either the starting or ending point for a 
segment. 
For: If a marker is a starting or ending point marker, specifies whether the marker defines a 
range of time or a segment. To change this setting, select an option in the drop-down list.  

 RangeA range of time on the timeline. If you have not defined a segment for which the marker is 
a starting or ending point, this value is selected by default. 

 SegmentA segment on the timeline. If you have defined a segment for which the marker is a 
starting or ending point, this value is selected by default. 

You cannot change this setting for a marker that is either the starting or ending point for a 
segment. 
Named: If a starting or ending point marker defines a segment, the name of the segment 
appears in this box. To change a segment name, type it in the box.  
This box is unavailable if the marker defines: 

 a cue point 
 a starting point for a range 
 an ending point for a range  

  
Delete: Deletes an existing marker from the timeline. Also renumbers any subsequent 
markers of the same type on the timeline. 
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OK: Inserts the marker on the timeline or sets any marker properties that you have edited. 
Also renumbers any subsequent markers of the same type on the timeline. 
Cancel: Closes the Marker Properties dialog box, without inserting a marker or setting any 
marker properties that you have edited. 
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Preferences Dialog Box 

The Preferences dialog box allows you to specify preferences for WebEx Recording Editor. 
Markers palette 
Always floats on top: If selected, the Markers palette always floats on top of the WebEx 
Recording Editor window and the Frame View window. 
Sort list of markers by: Sets the default sorting order for the list of markers on the Markers 
palette. 

 Time: Sorts the markers according to the time at which they occur.  
 Name: Sorts the markers by name.  
  

Segments palette 
Always floats on top: If selected, the Segments palette always floats on top of the WebEx 
Recording Editor window and the Frame View window. 
Sort list of segments by: Sets the default sorting order for the list of markers on the 
Markers palette. 

 Sequence: Sorts the segments according to the order in which they occur on the timeline.  
 Name: Sorts segments by name.  
  

Always floats on top 
Clipboard palette: If selected, the Clipboard palette always floats on top of the WebEx 
Recording Editor, Sequence Editor, and Frame View windows.  
Volume palette: If selected, the Clipboard palette always floats on top of the WebEx 
Recording Editor, Sequence Editor, and Frame View windows.  

  
OK: Sets any preferences that a user has edited; closes the Preferences dialog box; and the 
WebEx Recording Editor again becomes the active window. 
Cancel: Closes the Preferences dialog box without setting any preferences that a user has 
edited; and the WebEx Recording Editor again becomes the active window. 
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Define Segment/Segment Properties Dialog Box 

The Define Segment/Segment Properties dialog box allows you to specify properties about a 
new segment that you want to insert on a timeline or an existing segment on a timeline. 

  
Number: Indicates the number of the segment on the timeline. Segments are automatically 
numbered in sequential order. 
You cannot edit this number. 
Name: Specifies the segment's name. A segment name can consist of up to 64 characters and 
include any characters. To specify a segment's name, type it in the box. 
Starting point 
Time: Specifies the location of the segment's starting point on the timeline, in hours, minutes, 
and seconds (00:00:00.0). To edit the time value, click the number of number of hours, 
minutes, or seconds in the box, then do either of the following: 

 Type a new number. You can type a number of hours between 00 and 99, a number of minutes 
between 00 and 60, and a number of seconds between 00.0 and 60.0. 

 Click the Up button  to increase the number or click the Down button  to decrease the 
number. 

Marker name: Specifies the marker's name. A marker name is an alphanumeric string that 
can consist of up to 64 characters and include any characters. To specify a marker's name, 
type it in the box. 
Ending point 
Time: Specifies the location of the segment's ending point on the timeline, in hours, minutes, 
and seconds (00:00:00.0). To edit the time value, click the number of number of hours, 
minutes, or seconds in the box, then do either of the following: 

 Type a new number. You can type a number of hours between 00 and 99, a number of minutes 
between 00 and 60, and a number of seconds between 00.0 and 60.0. 

 Click the Up button  to increase the number or click the Down button  to decrease the 
number. 

Duration: Indicates the duration of the segment, in hours, minutes, and seconds 
(00:00:00.0).  
You cannot edit this value. 
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Marker name: Specifies the marker's name. A marker name is an alphanumeric string that 
can consist of up to 64 characters and include any characters. To specify a marker's name, 
type it in the box. 

  
Undefine: Makes the segment an unnamed range of recorded data, and renumbers any 
subsequent segments on the timeline. Clicking this button deletes neither the data that the 
segment contains nor the starting and ending point markers that define its boundaries. 
OK: Sets any segment properties that you have specified. 
Cancel: Closes the Define Segment/Segment Properties dialog box without setting any 
segment properties that you have specified. 
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Segments Palette 

The Segments palette contains a list of the segments that you have defined in a recording. 
  

Time: Indicates the starting time of each segment on the timeline, in hours, minutes, and 
seconds (00:00:00.0). Click the column heading to sort the segments in the list by time, 
according to the order in which they occur on the timeline. By default, the list is sorted by 
time in ascending order. 
Number: Indicates the number of each segment on the timeline. 
Name: Indicates the name of each segment in the recording. Click the column heading to sort 
the segments in the list by name, in alphabetical order, initially in ascending order. 

  
Go To: Moves the Current Location indicator to the left of the first snapshot in the selected 
segment.  
Play: Moves the Current Location indicator to the left of the first snapshot in the selected 
segment, then starts playback. 
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Sequence Editor Window 

Displays a list of any segments that you have defined on the timeline. 
  

Delete: Deletes the selected segment or segments from the recording, and the recorded data 
that they contain, without placing the recorded data on the Clipboard. 
Rename: Allows you to rename a segment. To rename a segment, click this button, type a 
new name, then press the Enter key. 
Merge: Merges two or more contiguous, selected segments into one. 
Clipboard Palette 

 
Current Location  
 Indicator 

 
  
Define Segment Dialog Box 

 
Elapsed Time and Duration Indicator 

 
File Properties Dialog Box 
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Marker Properties Dialog Box 

 
Markers Palette 

 
Preferences Dialog Box 
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Segment Properties Dialog Box 

 
Segments Palette 

 
Sequence Editor Window 

 
Set Location Palette 
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Split Segment Dialog Box 
  
Volume Palette 

 
Menu Bar 

The menu bar includes the following menus: 
 File Includes commands for opening and saving recordings, and quitting WebEx Recording 
Editor. 

 Edit Includes commands for editing a recording, such as cutting, copying, and pasting recorded 
data; defining markers and segments; and undoing and redoing changes to a recording. 

 Insert ncludes commands for inserting elements into a recording, such as markers and 
recorded data. 

 View Includes commands for displaying elements such as markers, segments, and frames of 
recorded data; and palettes on your screen. 

 Control Includes commands for setting or going to a current location, replaying a recording, 
and going to specific segments. 

 Window Comprises a list of all WebEx Recording Editor windows and Sequence Editor windows 
that are currently open.  

 Help Includes commands for viewing WebEx Recording Editor Help and version information 
about WebEx Recording Editor. 

Elapsed Time and Duration Indicator 

The Elapsed Time and Duration indicator shows the elapsed time during playback or editing, 
and the total duration of a recording, in hours, minutes, seconds, and tenths of a second. 

 
The Elapsed Time indicator tracks the movement of the Current Location indicator. 

Timeline 

The timeline shows the contents of a recording as snapshots, each of which represents 10 
seconds in the elapsed time of a recording. The upper part of the timeline displays time in 
increments of ten seconds and fractions of ten seconds. Specifically, the increment marks 
demarcate 2.5-second, 5-second, 7.5-second, and 10-second intervals of time. 
You can view the individual frames that correspond to the snapshot immediately preceding 
and the two snapshots following the Current Location indicator on the timeline. For details, see 
Viewing Frames on a Timeline. 

Toolbar 

The toolbar contains buttons that have the same functions as commands on the menus. 
Open: Allows you to open an existing 
recorded file stored on either your computer 
or a local server. 
Save: Allows you to save a previously saved 
file at the same location on either your hard 
disk or a local server, under the same file 
name.  
Cut: Removes the current selection on a 
timeline, and places it on the Clipboard.  
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Copy: Copies the current selection on a 
timeline, and places it on the Clipboard.   
Paste: Inserts the contents of the Clipboard 
at the current location on a timeline, 
preceding selected data on a timeline, 
preceding a selected segment in the Sequence 
Editor window, or in place of a selected 
marker. 
Insert Cue Point: Inserts a cue point marker 
at the current location on a timeline. 
Insert Starting Point: Inserts a starting 
point marker at the current location on a 
timeline. 
Insert Ending Point: Inserts an ending point 
marker at the current location on a timeline. 
Define Segment: Displays the Define 
Segment dialog box, allowing you to define a 
new segment on a timeline. 
Sequence Editor: Displays the Sequence 
Editor window, allowing you to view a list of 
segments that you have defined on a timeline, 
rearrange segments, and delete segments.  
Properties: Displays a Properties dialog box 
for the current selection, allowing you to 
specify or edit its properties. Possible 
selections include segments, ranges of 
recorded data, and markers. 
View Selected Frames:  Displays the Frame 
View window, which displays the frames that 
correspond to the snapshot immediately 
preceding and the two snapshots following the 
Current Location indicator on the timeline in 
the WebEx Recording Editor window. 
Segments Palette: Displays the Segments 
palette, which contains a list of any segments 
that you have defined on a timeline. You can 
select a segment in the list to navigate to it on 
the timeline. 
Markers Palette: Displays the Markers 
palette, which contains a list of any markers 
that you have inserted on a timeline. You can 
select a marker in the list to navigate to it on 
the timeline. 
Set Current Location: Sets the current 
location on a timeline by automatically moving 
the Current Location indicator to the left 
boundary of the snapshot, frame, or first 
snapshot in a segment that is currently 
selected. Clicking the downward-pointing 
arrow displays the Set Location palette, which 
allows you to move the Current Location 
indicator to a distant point on the timeline. 
Play: Starts playback of a recording at the 
current location. 
Pause: Pauses playback of a recording. 
Stop: Stops playback of a recording. 
Rewind: Rewinds a recording by moving the 
Current Location indicator one snapshot at a 
time in the WebEx Recording Editor window, 
or one frame at a time in the Frame View 
window.  
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Previous Segment: Moves the Current 
Location indicator to the beginning of the 
previous segment on the timeline and displays 
the first frame of the previous segment in the 
viewer. 
Next Segment: Moves the Current Location 
indicator to the beginning of the next segment 
on the timeline and displays the first frame of 
the next segment in the viewer. 
Fast Forward: Fast forwards a recording by 
moving the Current Location indicator one 
snapshot at a time in the WebEx Recording 
Editor window, or one frame at a time in the 
Frame View window.  
Volume: Displays, then hides, the Volume 
palette. The Volume slider allows you to easily 
and precisely set the volume during playback 
or editing. 
Mute/Unmute: Mutes, then unmutes audio 
during playback. 

Viewer 

The viewer is the area of the WebEx Recording Editor window in which playback occurs. The 
viewer displays the recorded images in a recording. 
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Glossary 

Clipboard palette 

A window that displays the current contents of the Clipboard, if any. 

cue 

To find a specific location in a recording by slowly advancing or backtracking through 
the recording while monitoring audio. 

cue point 

The location at which your insert a marker, allowing you to go directly to that precise 
location on the timeline. 

cue point marker 

A marker that indicates a point on the timeline that you want to locate again. 

cueing 

Advancing or backtracking through part of a recording, while monitoring audio, to 
select a location at which to insert a marker, or begin recording or playback. 

current location 

During playback, the location on the timeline of the data that currently appears in the 
viewer. 

Current Location indicator 

An indicator that shows the current location on the timeline during playback. You can 
drag this indicator to finely adjust the current location. 

ending point 

The location at which you insert a marker to define the end of a range of time or 
segment on the timeline. 

ending point marker 

A marker that indicates the ending of a range of time or segment. 

forward cueing 

Slowly advancing through a recording, while monitoring audio. 

frame 

A single image in a series of images that constitutes a recording. Each frame 
corresponds to 0.4 second on the timeline. 

increment mark 

A marking on the timeline that indicates fine increments of time--that is, ten-second 
increments and fractions of ten-second increments. 

marker 

A flag that you insert to indicate a point on the timeline at which an action is to occur 
or to which you can jump. You can insert pairs of markers to indicate the starting and 
ending points of a range of time or segment. 

merge 

To create a single segment from two or more segments that are currently selected. 

range of time 
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A part of a recording that includes one or more frames of recorded data on a timeline. 
You can specify a range of time using starting and ending point markers. If you specify 
properties for the range, it becomes a segment. 

recorded file 

A WebEx Recorded File, or .wrf file. 

recording 

The content in a .wrf file that a user has created using WebEx Recorder. This content 
consists of both audio and images of user interactions with interface elements on a 
computer screen. 

reverse cueing 

Slowly backtracking through a recording, while monitoring audio. 

segment 

A part, or range, of recorded data for which you specify a name and starting and 
ending points. Once you define a segment, you can move it to another location on a 
timeline, delete it, merge it with other segments, or split it into two segments. In the 
part of the timeline that shows increments of time, each segment of a recording 
appears in a different color. 

snapshot 

On the timeline, an image that represents 10 seconds in the elapsed time of a 
recording. Snapshots, which are representative images from a sequence of recorded 
images, are automatically generated at intervals of 10 seconds. 

split point 

The location at which you insert a marker to define the point at which to split an 
existing segment into two. 

starting point 

The location at which you insert a marker to define the beginning of a range of time or 
segment on the timeline. 

starting point marker 

A marker that indicates the beginning of a range of time or segment. 

timeline 

A strip that displays time in increments of ten seconds and fractions of ten seconds. It 
contains snapshots, or recorded images, each of which represents 10 seconds in the 
elapsed time of a recording. 

titles 

Text inserted into a recording. 

toolbar 

A row of buttons immediately below the menu bar in the WebEx Recording Editor 
window. 

transport controls 

Controls that allow you to record, play, pause/resume, stop, fast forward, and rewind 
a recording. 

truncate 

To delete all data that either precedes or follows the current location in a recording. 
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viewer 

The area of the WebEx Recording Editor window in which playback occurs. 

WebEx Player 

A stand-alone application that allows you to play back a WebEx Recorded File (.wrf). 

WebEx Recorded File (*.wrf) 

The file type designation for recordings that you make using WebEx Recorder. 

WebEx Recorder 

An application that allows you to record audio and images of user interactions with 
interface elements on a computer screen. WebEx Recorder is available as both a 
stand-alone application and an integrated tool in a meeting service. 
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